
ВВЕДЕНИЕ

Программный пакет Allegro PCB SI

объединяет в себе возможности проек�

тирования и моделирования печатных

плат быстродействующих устройств.

Тесная интеграция с редактором топо�

логии Allegro PCB Editor и схемным ре�

дактором Allegro Design Entry HDL поз�

воляет инженерам проводить верифи�

кацию проекта на всех этапах его

разработки. Это важно, поскольку чем

раньше в цикле проектирования будут

найдены и устранены проблемы, свя�

занные с целостностью сигналов, тем

меньше будут затраты на устранение

этих проблем на этапах физического

прототипирования и производства. Па�

кет PCB SI включает в себя несколько

приложений (см. ниже), которые ре�

шают определённый круг задач:
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● PCB SI – редактор для компоновки

платы и трассировки наиболее кри�

тичных цепей перед тем, как проект

будет передан инженеру по топо�

логии.

● Signal Explorer – графическая среда

для исследования, анализа и созда�

ния вариантов электрических со�

единений. Здесь в максимально до�

ступном виде отображаются все

электрические модели, входящие в

состав одной или нескольких цепей,

т.е. проводники, переходные отверс�

тия, источники и приёмники сиг�

налов и т.д. Signal Explorer имеет

встроенный процессор под назва�

нием Transmission Line Simulator 

(TLSim) – симулятор линий переда�

чи; TLSim работает с моделями ли�

ний передач, моделями устройств

(IBIS и DML), Spice�моделями и S�па�

раметрами. Он не может моделиро�

вать работу схем с моделями, опи�

санными на уровне транзисторов;

● Signal Noise – модуль, предназначен�

ный для быстрого анализа сигналов

на плате на предмет наличия отраже�

ний или оценки перекрёстных по�

мех во всём проекте или в некото�

рой группе сигналов. Результатом ра�

боты SigNoise являются подробные

текстовые отчёты, где можно видеть

результаты расчётов, а также осцил�

лограммы;

● Constraint Manager – система контро�

ля ограничений в проекте; является

общей для всей базы данных проек�

та на схемном и физическом уров�

нях. Constraint Manager управляет

компоновкой, размещением и интер�

активной трассировкой в реальном

времени или в пакетном режиме.

Здесь отображаются результаты рас�

чётов задержек сигналов на плате,

импеданса, дифференциальных пар

и т.д.;

● Signal Wave – виртуальный осцилло�

граф и редактор графиков. Здесь

можно обработать результаты ана�

лиза, расставить контрольные точ�

ки, посмотреть уровни сигналов на

различных временных интервалах,

отобразить спектр сигнала, диаграм�

му и т.д.;

● Model Editor – редактор моделей ком�

понентов, используемых при анали�

зе целостности. Помимо стандарт�

ных возможностей текстового редак�

тирования, включает такие функции,

как тестирование моделей и вывод

результатов в графической форме че�

рез SigWave.

ПЕРЕДАЧА ТОПОЛОГИИ

И МОДЕЛИРОВАНИЕ

На схемотехническом уровне под

топологией понимается не готовая фи�

зическая реализация цепи с проводни�

ками и переходными отверстиями, ко�

торой ещё нет, а набор электричес�

ки идеальных моделей, составляющих

цепь. Сюда входят соединения между

выводами, нагрузки, источники напря�

жения, источники и приёмники сигна�

лов. Для предтопологического модели�Рис. 1. Система управления ограничениями Constraint Manager

Предтопологический анализ целостности
сигналов в среде Cadence Allegro PCB SI

Анатолий Сергеев (Москва)

В статье рассказывается о программных решениях Cadence Allegro

PCB SI, предназначенных для анализа целостности сигналов на платах

быстродействующих устройств. Возможности данного продукта

позволяют инженерам минимизировать влияние паразитных параметров

печатного монтажа на целостность сигналов, значительно сократить

сроки выхода на рынок новых устройств, обеспечить их высокое

качество и надёжность. Рассмотрены приёмы работы в среде Allegro

PCB SI, демонстрирующие некоторые возможности пакета.
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рования любое соединение между выво�

дами может быть представлено в виде

идеальных линий передачи со значени�

ями задержки и импеданса, принятыми

по умолчанию в Allegro PCB SI.

Предположим, имеется плата с не�

сколькими высокоскоростными ин�

терфейсами, среди которых присут�

ствует DDR2. По этому интерфейсу

специализированная ИС соединяется с

микросхемой памяти. Посмотрим, ка�

ким образом можно передать тополо�

гию для одного бита данных из DDR2 в

Signal Explorer для проведения предто�

пологического анализа целостности.

Будем варьировать сопротивления со�

гласующих резисторов и добиваться

оптимальной формы сигнала во вре�

менной области.

Процедура передачи топологии в

Signal Explorer выглядит следующим

образом:

1) на схеме в Design Entry HDL перей�

дём в Constraint Manager через ме�

ню Tools → Constraints → Edit;

2) в электрическом домене перейдём в

директорию Net и выберем таблицу

Routing → Wiring. Сама таблица отоб�

разится справа от менеджера таб�

лиц. Здесь нас интересует сигнал

DDR2_DQ0; выберем его в списке

(см. рис. 1);

3) далее достаточно нажать правую

кнопку мыши и выбрать SigXplorer…

либо на панели инструментов на�

жать кнопку . С помощью этой

процедуры выбранная цепь со все�

ми её составляющими будет пере�

дана для анализа в Signal Explorer.

Необходимо сделать уточнение,

что, прежде чем передавать цепь, её

следует подготовить, а именно, на�
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Рис. 2. Программа для анализа целостности сигналов Signal Explorer
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значить модели компонентам и

указать напряжение. Правильно

подготовленные библиотеки и

настроенный проект почти всегда

гарантируют минимальное количе�

ство настроек перед моделирова�

нием. В нашем случае для упроще�

ния мы рассматриваем отлаженную

ранее схему;

4) в окне Signal Explorer (Topology Editor)

отобразится электрическая модель

цепи (см. рис. 2). Видно, что цепь

состоит из передающего и принима�

ющего буферов (U13, U28), соеди�

нённых с идеальными линиями пе�

редачи (TL21 – TL23) с параметрами

по умолчанию – задержкой 0,5 нс

(2800 Мил) и импедансом 60 Ом. Так�

же на схеме присутствуют нагру�

зочные резисторы (RN42 и RN54)

и источники постоянного напряже�

ния 0,9 В;

5) перед моделированием необходи�

мо настроить параметры сигнала в

драйвере. Для этого кликнем текст

TRISTATE на верхней части символа

U13. В появившемся окне в секции

Stimulus State выберем Pulse и наж�

мем OK для завершения настройки

(см. рис. 3);

6) для запуска моделирования из окна

Signal Explorer можно нажать кнопку

на панели инструментов. По

окончании моделирования пере�

ходного процесса в окне SigWave

автоматически появится осцилло�

грамма (см. рис. 4).

Основная задача предтопологичес�

кого моделирования заключается в вы�

боре оптимальных согласующих ре�

зисторов на концах линий передачи.

Другая важная задача – выбор импе�

данса, который обеспечит минималь�

ное отражение сигнала и низкий уро�

вень помех. В Signal Explorer есть

инструменты, позволяющие варьиро�

вать значения вышеуказанных пара�

метров. Кроме того, вы можете устано�

вить зависимость изменения одного

или нескольких параметров друг от

друга для различных моделей.

Для подбора оптимальных нагрузоч�

ных резисторов поступим следующим

образом:

1) на панели Parameters в окне Signal

Explorer раскроем список парамет�

ров элементов топологии. Для нача�

ла нас интересует резистор RN54.

Выберем Circuit → PCB_SI_001 →
→ RN54. Ещё быстрее это можно

сделать, если выбрать значение со�

противления на самом резисторе в

рабочем поле программы. Щёлкнем

значение «54 Ом» на панели Parame�

ters, а затем кнопку рядом с этим

значением (см. рис. 5);

2) чтобы проверить уровень сигнала

для разных нагрузок, необходимо

задать диапазон значений сопро�

тивления, в пределах которого бу�

дет выполнено исследование сигна�

ла. В окне Set Parameters: Resistance в

секции Linear Range установим пре�

дел от 50 до 62 Ом с числом итера�

ций моделирования 5 (см. рис. 6);

3) для резистора R42 установим зна�

чения сопротивлений при модели�

ровании такие же, как и для R54.

Это можно сделать с помощью выра�

жения в нижней части окна Set

Parameters: Resistance для R42. Выбе�

рем в списке Variables RN54.resistance

и внесём его в поле Expression

с помощью кнопки Append Var

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ
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Рис. 3. Настройка источника сигнала в Signal Explorer

Рис. 4. Результат моделирования в SigWave
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(см. рис. 7). Это сократит количество

итераций с 25 до 5, что значительно

упростит поиск решения для данно�

го случая;

4) теперь, как и в прошлый раз, выбе�

рем Analyze → Simulate. При этом

появится окно Sweep Sampling, где

будет предложено ещё раз указать

число итераций моделирования, не�

обходимое для выполнения задан�

ной вариации параметров. Нажмем

Continue, и в нижней части окна

Signal Explorer на панели Results

появятся результаты вычислений

согласно выбранным значениям

сопротивлений нагрузочных резис�

торов (см. рис. 8).

Видно, что каждому шагу моделиро�

вания был присвоен номер в столбце

SimID. Выбирая шаги из списка, можно

просматривать осциллограмму, соот�

ветствующую каждому результату. До�

статочно нажать правую кнопку мы�

ши и выбрать View Waveform для вы�

вода графических данных. Можно

выбрать несколько результатов или

сразу все и просмотреть их в окне Sig�

Wave на одном графике. На панели Re�

sults автоматически появляются вычис�

ления для широкого набора харак�

теристик сигнала, таких как выбег

(Overshoot), на которые можно ори�

ентироваться при нахождении опти�

мального варианта. После просмотра

результатов необходимо выбрать ме�

ню Edit → Transform For Constraint

Manager для приведения всех парамет�

ров к значениям по умолчанию и уста�

новки ограничений.

Варьируя параметры и характерис�

тики различных элементов цепи в Sig�

nal Explorer, инженер по целостности

сигналов добивается оптимального

вида исследуемого сигнала. Характе�

ристики сохраняются в виде шабло�

на ограничений и могут быть авто�

матически переданы в Constraint Ma�

nager. Посмотрим, каким образом

можно указать дополнительные огра�

ничения через Signal Explorer для на�

шего сигнала DDR_DQ и затем приме�

нить их для всей 32�битной шины

DDR2 в проекте:

1) для начала выберем из меню Signal

Explorer окно для указания ограни�

чений Setup → Constraints. На каж�

дой из вкладок можно указать опре�

делённый вид ограничений. Устано�

вим значения для минимального и

максимального уровней относи�

тельной задержки сигнала. Для это�

го перейдём на вкладку Prop Delay;

2) теперь необходимо указать пару вы�

водов, между которыми будет кон�

тролироваться задержка. Для этого в

поле Pins/Tees выберем U13.AL20, а

затем U28.G8. Эти наименования ав�

томатически появятся в секции Rule

Editing, расположенной справа (ана�

логично выводы можно выбирать

мышью непосредственно на рабо�

чем поле программы);

3) в списке Rule выберем Lenght, т.е. будем

указывать задержку в единицах длины

проводников. Укажем 2800 Мил для

минимальной длины и 3300 Мил для

максимальной длины. Затем нажмём

Add, и новое ограничение появится в

поле Existing Rules сверху (см. рис. 9);

4) передадим ограничения Constraint

Manager в схемотехнический редак�

тор Design Entry HDL. Для этого в Sig�

nal Explorer выберем File → Update

Constraint Manager или нажмём

кнопку . Эта процедура отправит

новый шаблон ограничений в базу

55WWW.SOEL.RUСОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 9  2012

Рис. 5. Настройка параметров моделей в Signal Explorer

Рис. 6. Настройка диапазона значений

сопротивления для нагрузочных резисторов

Рис. 7. Установка связи между параметрами

нескольких резисторов
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Constraint Manager в проекте для це�

пи DDR2_DQ0. Также на экране по�

явится отчёт с информацией о пе�

реданных ограничениях Electrical

CSet Apply Information. По окончании

процедуры будет предложено со�

хранить шаблон с ограничениями в

файле с расширением TOP. В после�

дующем можно будет передавать

шаблон между проектами, что созда�

ёт большие удобства для разработ�

чиков и экономит время;

5) вернемся в Constraint Manager. Те�

перь в столбце Referenced Electrical

Cset необходимо присвоить шаблон

TOP1 всей шине DDR2. Для этого

достаточно выбрать первый и по�

следний сигналы с помощью Shift, а

в списке выбрать TOP1 (см. рис. 10);

6) откроем раздел Min/Max Propagation

Delay. Все цепи, входящие в состав

нашей шины, получили задержку

сигнала согласно электрическому

ограничению, указанному в Signal

Explorer (см. рис. 11). Таким обра�

зом, процесс назначения ограниче�

ний связывает проектирование и

моделирование в Allegro в единый

процесс.

В редакторе топологии PCB SI все

назначенные на схеме ограничения бу�

дут управлять процессом трассировки.

Если задержка сигналов на плате будет

отличаться от заявленной в Constraint

Manager, то система предупредит нас

об этом. Все значения реальной за�

держки, требуемой задержки и их раз�

ность можно увидеть в Constraint Mana�

ger. Здесь также можно изменять и до�

полнять любые ограничения.

Пропустим несколько важных шагов –

генерацию списка соединений, разме�

щение компонентов – и обратимся к

почти готовой топологии. Посмотрим,

как происходит процесс трассировки,

управляемой ограничениями. Допустим,

осталась незавершённой только одна

цепь нашей шины, а именно DDR_DQ0,

как показывает Constraint Manager (см.

рис. 12). На плате видно, что цепь

DDR2_DQ0 ещё не готова и ошибка по�

мечена специальным маркером. При ин�

терактивной трассировке и подстройке

длины проводника в реальном времени

появится индикатор, который покажет

инженеру соответствие этой длины заяв�

ленному ограничению. На данном ин�

дикаторе будет отображаться разность

между требуемой и реальной задержка�

ми сигнала. Зелёный цвет индикатора

означает, что длина трассы удовлетво�

ряет ограничению, красный – длина вы�

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ
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Рис. 8. Результаты анализа на панели Results в окне Signal Explorer

Рис. 9. Установка ограничений на задержку сигналов в Signal Explorer

Рис. 10. Назначение шаблона электрических ограничений для цепей в Constraint Manager
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ходит за пределы допуска (см. рис. 13).

В Constraint Manager также появятся

результаты работы (см. рис. 14).

Следующий этап работы – постто�

пологический анализ целостности сиг�

налов и корректировка топологии по

его результатам. Это – тема для отдель�

ной статьи. Здесь возможности Allegro

PCB SI неисчерпаемы. Как и в случае

со схемой, любая цепь может быть пе�

редана из редактора топологии в Signal

Explorer для моделирования, и там же

могут быть назначены ограничения

для Constraint Manager. Однако в этом

случае модель цепи будет содержать в

себе не идеальные линии передачи, а

реальные модели проводников и от�

верстий, привязанных к топологии

платы и материалам.

ЗАКЛЮЧЕНИЕ

Таким образом, все процессы проек�

тирования быстродействующих плат

в пакете Allegro тесно связаны с систе�

мой анализа целостности сигналов Al�

legro PCB SI, что обеспечивает высо�

кую точность и качество проектов.

Важную роль в этом процессе играет

тесное взаимодействие между инжене�

ром�схемотехником, инженером по

топологии и инженером по анализу

целостности сигналов. Благодаря об�

щей базе проекта в Allegro, такое взаи�

модействие становится максимально

продуктивным.

Предтопологический анализ це�

лостности сигналов проводится на

этапе разработки схемы с целью

формирования шаблонов с электри�

ческими ограничениями. Далее эти

ограничения передаются в редактор

топологии PCB SI для компоновки

проекта, моделирования и предвари�

тельной трассировки наиболее кри�

тичных цепей. Здесь электрические

ограничения корректируются и ста�

новятся более сбалансированными.

Далее вся база проекта с ограниче�

ниями передаётся инженеру по то�

пологии в Allegro PCB Designer.

Трансляции данных между Allegro

PCB SI и Allegro PCB Designer не тре�

буется, что позволяет избежать свя�

занных с этим возможных потерь в

базе проекта. Allegro PCB Designer, в

отличие от Allegro PCB SI, «заточен»

именно под трассировку плат с учё�

том технологичности проектов и

привязкой к возможностям конкрет�

ного производителя, обеспечения

контролепригодности и надёжности

плат.
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Рис. 11. Задержка сигналов, назначенная через шаблон TOP1

Рис. 12. Constraint Manager в редакторе топологии Allegro PCB SI

Рис. 13. Подстройка сигнала в Allegro PCB SI в соответствии с ограничением

Рис. 14. Значения требуемой и реальной задержек сигнала в Constraint Manager
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